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Overview

Stellar EDB to PST Converter converts mailboxes from MS Exchange database files into PST files. It
allows you to convert Online and Offline Exchange database (EDB) to PST files. The software also
provides preview of mailbox items such as - Emails, Contacts, Calendar, Notes, Attachments, Sent items,

etc.
What's new in this version?
e Support for MS Exchange Server 2013.
e Export offline EDB data to live Exchange Mailbox.
e Search particular mails from the converted file.
e Convert multiple EDB files.
e Save converted data in HTML, RTF, PDF formats.
Key Features of Stellar EDB to PST Converter:
o User-friendly and secure software.
e Converts Online Exchange database (EDB) to PST file(s).
e Converts Offline Exchange database (EDB) to PST file(s).
e Supports PUB.EDB files for Offline conversion.
e Selective conversion of user mailboxes to PST file(s).
e Supports MS Office 2013, 2010, 2007, 2003.
e Supports MS Exchange Server 2013 / 2010/ 2007 / 2003 / 2000/ 5.5.

e Provides preview of mailboxes and mailbox items such as - Emails, Contacts, Calendar, Notes,

Sent items, Attachments, etc.

e Compatible with Windows 8 / Windows 7 / Windows Vista / Windows Server 12 / Windows Server
8.



Installation Procedure

Before installing the software, check that your system meets the minimum system requirements:

Minimum System Requirements:

Processor: Pentium Class

Operating System: Windows 8 / Windows 7 / Windows Vista / Windows Server 12 / Windows

Server 8
Memory: Minimum 1 GB
Hard Disk: 50 MB of Free Space

MS Outlook: 2013, 2010, 2007, 2003

To install the software, follow these steps:

Double-click StellarEDBtoPSTConverter.exe executable file to start installation. Setup -Stellar

EDB to PST Converter dialog box is displayed.
Click Next. License Agreement dialog box is displayed.

Choose | accept the agreement option. Next button will be enabled. Click Next. Select

Destination Location dialog box is displayed.

Click Browse to select the destination path where the setup files will be stored. Click Next. Select

Start Menu Folder dialog box is displayed.

Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog

box is displayed.
Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed.

Review the entries. Click Back if you want to change them. Click Install to start installation. The

Installing window shows the installation process.

After completing the process, Completing the Stellar EDB to PST Converter Setup Wizard

window is displayed. Click Finish.

Note: Clear Launch Stellar EDB to PST Converter check box before clicking Finish to prevent the

software from launching.



Launching the Software

To launch Stellar EDB to PST Converter in Windows 8:
e Click Stellar EDB to PST Converter tile on the home screen. Or,
o Double click Stellar EDB to PST Converter icon on the desktop.
To launch Stellar EDB to PST Converter in Windows 7 / Vista:
e Click Start -> Programs -> Stellar EDB to PST Converter -> Stellar EDB to PST Converter. Or,
e Double click Stellar EDB to PST Converter icon on the desktop. Or,

e Click Stellar EDB to PST Converter icon in Quick Launch.



User Interface

Stellar EDB to PST Converter software has a very easy to use Graphical User Interface. The user

interface contains features required for conversion.

After launching the software, you will see the main user interface as shown below. You can select either

of the conversion mode to start the conversion process.
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The user interface contains Menus and Buttons that let you access various features of the software with

ease.



Menus

File Menu
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EDE %Scan Info Scan Info | Wizard Message
File Scan Info Tools

Select EDB

Use this option to select the EDB file which you

want to convert.

Save

Use this option to save the converted file.
Stop

Use this option to stop the conversion process.
Save Scan Info

Use this option to save the scan information of

the converted files.

Load Scan Info

Use this option to load the scan information.
Update Wizard

Use this option to check for both, latest minor

and major versions available online.
Search Message

Use this option to search for particular mails

from the converted file.



Logs Menu
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Log Report

Use this option to view / save the log report.

Registration

Use this option to register the software after

purchasing.

Help

Use this option to view the help manual for the

software.
Order

Use this option to buy Stellar EDB to PST

Converter software.
Support

Use this option view the support page of

stellarinfo.com
Knowledgebase

Use this option to visit Knowledgebase articles of

stellarinfo.com


http://www.stellarinfo.com/email-repair/edb-pst-converter/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/

Style Menu

Style -
® | Blue Style
Elack Style

Silver Style
Aqua Style

Enquiry

Use this option to submit enquiry to

stellarinfo.com
About

Use this option to read information about the

software.

Use this option to switch between various themes
for the software, as per your choice.


http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/
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Registration

Click this button to select the EDB file which you want to convert.

Click this button to save the converted file.

Click this button to stop the conversion process.

Click this button to save the scan information of the converted files.

Click this button to load the scan information.

Click this button to check for both, latest minor and major versions available online.

Click this button to search for particular mails from the converted file.

Click this button to view / save the log report.

Click this button to register the software after purchasing.



Support

KB

Knowledge
base

Enquiry

About
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Click this button to view the help manual for the software.

Click this button to buy Stellar EDB to PST Converter software.

Click this button view the support page of stellarinfo.com.

Click this button to visit Knowledgebase articles of stellarinfo.com.

Click this button to submit enquiry to stellarinfo.com.

Click this button to read information about the software.



Ordering the Software

Click http://www.stellarinfo.com/email-repair/edb-pst-converter.php to know more about Stellar EDB to

PST Converter.

To purchase the software online, please visit http://www.stellarinfo.com/email-repair/edb-pst-

converter/buy-now.php

Alternatively, click Order icon in Help Menu on Menu Bar to purchase the software online.
Select either of the methods given above to purchase the software.

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required

to activate the software.
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Registering the Software

You can visit http://www.stellarinfo.com/email-repair/edb-pst-converter.php to download demo version of

Stellar EDB to PST Converter software. The demo version is just for evaluation purposes and you must
eventually register the software to use its full functionality. Once you purchase the software, you will

receive a key using which you can register the software.
You can register the software using any of the following methods:
e Online Registration

After purchasing the software, a serial number will be sent via email, which is required to register
the software. You need to enter the serial number, which is then verified by a license server and on

verification, the software is registered.

e Manual Registration

To register the software manually, you will need to generate a PHX_ REG.txt file and malil it to

support@stellarinfo.com. After verification of the serial number and purchase details, the site key,

which is required to register the software manually, will be sent to your email address.

Note: If the software is downloaded from http://www.stellarinfo.com/email-repair/edb-pst-converter/buy-

now.php (i.e., ESD version), it must be registered using Serial Number (received through email after

purchasing the product) to use all the features of the software.

If the software is installed using the product installation CD (i.e., BOX version), hardware lock, that is

available with the software kit, is mandatory for the functioning of the software.
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Online Registration

To register the software online:

Hellar Phoeno - Electronic Registration Wizard

To complata the sollvane iegistialion you need bo anber the senal number

The zenial number has been sent bo you through emad by our
payment-procesang sgent, mmedistely alter puichase

125MHESEAYSGEE

I Canced | + Previous ; Hext »

Launch demo version of
Stellar EDB to PST
Converter software.

In Registration Menu on
Menu Bar, Click
Registration.

In Registration Option
dialog box, select | have
the registration key.

Select Online
Registration. Click OK. A
warning will appear, click
Yes to continue.

In Stellar Phoenix -
Electronic Registration
Wizard, click Next.

Type the serial number
(received through email
after  purchasing the
product) in serial number
field. Click Next.

The  software  would
automatically
communicate with the
license server. After the
registration is done, click
Finish to complete the
registration process.

Note: You can generate PHX_REG.txt file manually via online activation. View Manual Registration to

perform the process of generating PHX_REG.txt file.
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Manual Registration
To register the software manually:
1. Launch demo version of Stellar EDB to PST Converter.
2. In Registration Menu on Menu Bar, click Registration.
3. In Registration Option dialog box, select | have the registration key.
4. Select Online Registration. Click OK. A warning will appear, click Yes to continue.
5. InWelcome to Stellar Phoenix - Electronic Software Registration wizard, click Cancel.

6. Stellar EDB to PST Converter dialog box will open, click Yes.

Stellar EDB to PST Converter [
Onlne activation faled. Do you vant to send sarial number to
Stedar for manual actvation?
Y- RS-

7. In Manual Registration dialog box, enter the serial number that you receive once you purchase

the software. Click Next.

Stellar EDE to PST Converter - Manual Registration ﬁ

Enter Serial Number ; 173

Where i my sarial rumber?

The sarial rumber has been sant to you through email by cur payment -
processing agent, immediately after purchase

Mote: The serial number will be delivered at the same emai id, which you
spedfied in your purchase details,

MNext Cancel

8. A file named PHX_ REG.txt is created on your desktop. Email it to support@stellarinfo.com. Click
Finished.
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mailto:support@stellarinfo.com

Stellar EDB to PST Canverter (]

The information required for manual activation has been saved on your
desktop in a file named PHY_REG. txt

How to send the above information to us?
Emai the file tous at support@stellaninfo.com
Or you can also fax the information bo us at (366) 5598922

All marwsal registration process will take a maximum of 1 business day for
completion

Finisihed

e

9. After verifying the purchase details, you will receive the site key, which is required to register the

software manually.

10. After receiving the Site Key, open Stellar EDB to PST Converter. In Registration Option dialog

box, select | have the registration key.
11. Select Manual Registration and Click OK.

12. Enter the Site Key in Enter Site Key dialog box. Click Validate.

Stellar EDB to PST Converter et

Enter Site Key : [?ESEHHEAT-HFM 52

Where is my Site Key?

Site key is the pre-paid serial number, which you have received from
Stellar's payment gateway after a successful purchase,

Vaidate | Cancel

Note: The site key is delivered to the email address through which the serial number is sent.
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Updating the Software

Stellar releases periodical software updates for Stellar EDB to PST Converter software. You can update
the software to keep it up-to-date. These updates can add a new functionality, feature, service, or any
other information that can improve the software. Update option of the application is capable of checking
for latest updates. This will check for both latest minor and major versions available online. You can easily
download minor version through the update wizard. However, the major version, if available, has to be
purchased. While updating the software, it's recommended to close all the running programs. Note that

demo version of the software cannot be updated.
To update Stellar EDB to PST Converter:
e Click Update Wizard icon from File Menu.

e Stellar Phoenix Update Wizard window opens. Click Next. The wizard will search for latest

updates, and if it finds any new updates, a window will pop up indicating its availability.

e Click Next and the software will download the files from the update server. When the process is

complete, the software will upgrade to the latest version.
Live Update may not happen due to following reasons:
e Internet connection failure
e Updates are not available
e Unable to download configuration files
e Unable to locate updated files or version
e Unable to locate executable file

Note: If a major version is available, you need to purchase the software in order to upgrade it.
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Stellar Support

Our Technical Support professionals will give solutions for all your queries related to stellar products.
You can either call us or go online to our support section at http://stellarinfo.com/support/

For price details and to place the order,

converter/buy-now.php

Chat Live with an Online technician at http://stellarinfo.com/support/

click http://www.stellarinfo.com/email-repair/edb-pst-

Search in our extensive Knowledgebase at http://www.stellarinfo.com/support/kb/

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php

E-mail to Stellar Support at support@stellarinfo.com

Support Helpline

Monday to Friday [24 Hrs. a day]
USA (Tollfree- Pre Sales Queries)
USA (Post Sales Queries)
UK (Europe)
Australia & Asia Pacific
Netherlands Pre & Post Sales Support
Worldwide
Skype Id

Email Orders

+1-877-778-6087

+1-732-584-2700

+44-203-026-5337

+61-280-149-899

+31-208-111-188

+91-124-432-6777

stellarsupport

orders@stellarinfo.com
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Convert Offline EDB

e Select EDB File

e Convert Files

Select EDB File

To Select an EDB File:
e Click Select EDB from File Menu.

e In Stellar EDB to PST Converter dialog box, select Offline EDB from Select Conversion Mode

section.

e Click Open EDB to select the EDB file that you want to convert.

-

Stellar EDB to PST Converter =

Select Conversion Mode
* Offline EDB

" Orline Exchange

Select EDE File
[D:\mﬁvm.em Open EDB

Find EDB

Stellar EDB to PST Converter also allows you to search for EDB files in your computer's hard drive, in

case you don't know their location.
To Find an EDB File:
e Click Find EDB in Stellar EDB to PST Converter dialog box. Find EDB File dialog box opens.

e From Find Options section, select the required drive from the Look in list box or click Look in to

search for EDB files within a specific folder. Click Start to start searching for EDB files.
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After the search is complete, list of EDB files found in the selected drive / folder is shown in Find

EDB File dialog box as shown below:

Find EDB File

W Find in Subfolders .—ﬂﬂ-:
Find Results: Tatal2 Exchange Data Fike(s) Found
Name Size Created | oo
D:\ED8'dientpst.edh 3.48G8 Mon Feb 10 10:... Mon
O\ EDED0 174873 Maibox Database SECOMND ... 15.25GB Man Feb 10 11:... Mon
L L1Ld { [
o Cearist | .. Cancel

e Select file you wish to convert from this list and click OK.



Convert Files

e After selecting the EDB file that you want to convert, click Start to start the conversion process.
e Once the conversion process is complete, you can preview the converted file.

Left pane displays selected EDB filename under Root node in a tree like structure while the Middle
pane displays the list of converted mails. Click on any mail in the middle pane to see it's content, which
is displayed in right pane as shown below.
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Stellar EDB to PST Converter also allows you to search for particular mails from the converted file.
To search for particular mails:

e Click on Search Criteria tab in Preview window, or select Search Message from File Menu.
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Enter your requirements for any of the given attributes and then click Search to search for mails.

However, you can only select one EDB at a time to search for mails.
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Convert Online Exchange

22

Connect to Single / All Mailboxes
Convert Online EDB
Grant Full Mailbox Rights in MS Exchange Server 2003 and 2000

Grant Full Mailbox Rights in MS Exchange Server 2013, 2010 and 2007



Connect to Single / All Mailbox(s)

For Online conversion of EDB to PST Files, you need to connect to mailboxes on Exchange Server.
To convert EDB from a single mailbox on Exchange Server:

e Click Select EDB from File Menu.

e In Stellar EDB to PST Converter dialog box, select Online Exchange from Select Conversion
Mode section.

Stellar EDB to PST Converter 3

Select Conversion Mode

" Offline EDB

i* Online Exchange

Connection Options

{* Connect to single mailbox

" Connect to all maiboxes on server

Microsoft Exchange Server Information

[v Exchange Server 2010,/2013

Email: | alex@exch 1. local

Server Mame: | exchil.local

USEF P'aSSWﬂrd' | B
QK

e Select Connect to a Single Mailbox from Connection Options.

e Enter Mailbox Name and Server Name (for MS Exchange 5.5 / 2000 / 2003 / 2007) or check the
Exchange Server 2010 / 2013 checkbox to enter Email ID, Server name and password (for MS

Exchange 2010 / 2013) in Microsoft Exchange Server Information section.

e Click OK. The application will start connecting to the Exchange Server and once the connection is
established, a window containing hame and status (connected / disconnected) of the mailbox will

be displayed.
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[ Stellar EDB to PST Converter 2
[ Benutzarname | Stalus |
Administrator virbundene
Verbundene Fostfacher: 1 Bicht verbundens Postfscher verbmeden
Micht verbundene Postfacher: 0
1

To convert EDB from all mailboxes on Exchange Server:
e Select Connect to all Mailboxes on Server from Connection Options.

e Enter Admin and Server Name (for MS Exchange 5.5 / 2000 / 2003 / 2007) or check the
Exchange Server 2010 / 2013 checkbox to enter Admin Email ID, Server name and password

(for MS Exchange 2010 / 2013) in Microsoft Exchange Server Information section.

e Click OK. Once the application has established a connection with the Exchange Server, a window
displays list of all mailboxes and their status with total humber of connected / disconnected

mailboxes.
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A

User Name | Stalus | =
Admimistrator Connected
aliewvi Connected
alsace Connected
barsen Disconnected
becker Disconnected
Carmy Disconnectad
chals Connected
cymru Disconnected
david Connected
durand Connected
eest Connected
fischer Disconnectzd
francais Connected
ison Disconnected
kemow Disconnected
leroy Connected
marshal Digconpectad
meyer Disconnected
moral Connected
MS Jangra Connected
norge Connected
petit Connected
potters Digconnected .
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Convert Online EDB

Once Stellar EDB To PST Converter establishes a connection with Exchange Server, a window displays
mailbox and its status. If you have selected Connect to all mailboxes on server option, the window

displays a list of all mailboxes and their status with total number of connected and disconnected

mailboxes. Click OK to close the window and preview the converted file.

Left pane displays selected EDB filename under Root node in a tree like structure while the Middle pane
displays the list of converted mails. Click on any mail in the middle pane to see it's content, which is

displayed in right pane as shown below.
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Grant Full Mailbox Rights in MS Exchange Server 2003
and 2000

In Exchange Server 2003 and 2000, by default even accounts having Enterprise Administrator privileges
are not allowed to access all mailboxes of the Exchange Server. Even administrators have no right to
open mailbox on any of the servers. Thus, you can access only mailboxes of your account, even if you
have full admin, domain admin or enterprise admin rights. This limitation can be overcome by certain
methods. But these methods can be applied only if they confer with security and privacy policies. We will

discuss these methods to grant Full Mailbox Permission access rights in detail.
Access a Single Mailbox

If you have the proper Exchange Server administrative rights, you can follow the underlying procedure to

access a single mailbox in Exchange 2003 and 2000.
e Click Start menu.
¢ In Run dialog box, type mmc dsa.msc.
e Click OK. Active Directory window is displayed.
o If Advanced Features is not selected, select it in View menu options.

e In the list of users shown in Active Directory, right-click on the user whose mailbox permission is

to be given. Select Properties option.
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e Inthe [User] Properties dialog box, click Exchange Advanced tab.
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e In Exchange Advanced window, click Mailbox Rights button. [User] Permission dialog box is

displayed.
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e In Permission dialog box, click the user or group whose mailbox is to be accessed. If user is not
present in the list click Add button. Enter the object name and click OK.
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e Select Full mailbox access option under Allow column.
e Click Apply and then click OK.

Access to Mailboxes of a Specific Mailbox Store

If you have proper Exchange Server administrative rights, you can follow the underlying procedure to

access mailbox on a specific store in Exchange Server 2003 and 2000.
¢ Run Exchange System Manager (ESM).
¢ Navigate and select required Mailbox Store in the appropriate server object.

¢ Right-click on Mailbox Store and click Properties option. Properties dialog box appears.
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e Click Security tab option.
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e In Properties dialog box, click the user or group whose mailbox is to be accessed. If user is not

present in the list click Add button. Enter the object name and click OK.
e Select Full Control options under Allow column.
e Click Apply and then click OK.
If Mailbox is on a Specific Server

If you have the proper 'Exchange Server' administrative rights, you can follow the underlying procedure to

access mailbox on a specific Server in Exchange 2003 and 2000.
e Start Exchange System Manager.

o Navigate to desired Administrative Group and then the Server under the server’'s node. Right-

click on the selected server and choose Properties option.
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e In Properties dialog box, click the user or group whose mailbox is to be accessed. If user is not
present in the list click Add button. Enter the object name and click OK.

e Select Full Control under Allow column.
e Click Apply and then click OK.

Wait for few minutes depending on number of domain controllers, Global Catalogs and site replication

schedules and intervals for the changes to take place.
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Grant Full Mailbox Rights in MS Exchange Server
2013, 2010 and 2007

If you have MS Exchange Server 2013, 2010 or 2007 with .Net framework 3.5 or higher, then you need to
use Stellar Phoenix Server Console.exe to provide the Full Mailbox Permission to disconnected

mailboxes.

To grant Full Mailbox Rights using Stellar Phoenix Server Console.exe:

e Launch Stellar Phoenix Server Console.exe. Login dialog box opens.

ﬁﬁtellar Phoenix Server Console - Login Details

Dramain Mame ExCHAMGE 2010
ﬁ’ ?5 ) |
e
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PaSSWD[d Ixxxxxxxxxxxxxxxxxx:1

Help | Login

e After providing Domain Name, User Name and Password, you will get a window with list of

mailboxes as shown below:
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e To select all the mailboxes, press Select All.
e To deselect all the mailboxes, press Unselect All.
e To give Full Mailbox Rights to selected mailbox (s), press Add Admin Rights.

e Toremove Full Mailbox Rights from the selected mailbox (s), press Remove Admin Rights.

Note: .Net framework 3.5 should be installed on the 'Server' to run Stellar Phoenix Server Console.exe.
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Save & Load Scan Info

With Stellar EDB to PST Converter, you can save the scan information of the converted files, in case

you need to access it at a later stage.
To save the scan info:
e From File Menu, select Save Scan Info.

e Click Browse to select the destination where you want to save the scan info. Click OK.

To load the scan info:
e From File Menu, select Load Scan Info.

e Click Browse to select the .img file from which you want to load the scan info. Click OK.

Stellar EDE to P5ST Converter =2

Click ‘Browse’ to select saved scan information

C:Wsers\administrator \Desktop\Stellar_Scanned File Friday, Browvse

(0]4
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Save Converted Files

Stellar EDB to PST Converter allows you to save the converted files in various formats like PST, MSG,
EML, HTML, RTF and PDF or export them to an Exchange Mailbox.

To save the converted files:
e Click Save from File Menu.

e Select the required format and then select the destination where you want to save the file. Click

OK.
[ Stellar EDB ko PST Comeerter 3
Save As
+ PST i~ MSG - " HML " RIF " PDE
Destnation Path:
| C:VWsers\pdministrator \Deskiop \PST Browse
oK,

Using Stellar EDB to PST Converter, you can save individual mailboxes in either of the given formats.
To save mailboxes individually, simply right-click on it and:

e Select Save as PST to save the mailbox in PST format.

e Select Save as MSG to save the mailbox in MSG format.

e Select Save as EML to save the mailbox in EML format.

e Select Save as HTML to save the mailbox in HTML format. (Attachments cannot be saved,

however, their names are visible)

e Select Save as RTF to save the mailbox in RTF format. (Attachments cannot be saved, however,

their names are visible)

e Select Save as PDF to save the mailbox in PDF format. (CC of the mails is not shown and

attachments cannot be saved, however, their names are visible)
Note: You can also right click on a message to save it individually in all formats except PST.

You can export the converted file to an Exchange Mailbox as well, using the following steps:
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¢ Right Click on the tree item which you want to export and select Export to Exchange Mailbox.
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e In Connect to Exchange Server Mailbox dialog box, choose Connect to single mailbox or

Connect to all mailboxes on server, based on your requirement.

e In Connect to Exchange Server Mailbox dialog box, select Connection Options (either Connect to
single mailbox or Connect to all mailboxes on server) and then enter Microsoft Exchange
Server Information details. Click OK.

e In Export To Mailbox dialog box, double click the mailbox to which you want to export the mails.
Click OK.
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Stellar EDB to PST Converter also allows you to save only those messages, which you have searched

for using Search Criteria option.
To save search results:
e Click Save from File Menu.
e Select Save Search Results and click OK.

e Select your preference from Save Search Results section, select the required format, and then

select the destination where you want to save the file. Click OK.

Steltar EDE to PST Converter 3

Save Search Readts
% Ariy Criberia

f+ psT " M5G e £ HML " RTF " POF

Note: After search is complete, you can right click on messages to save them individually.
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View Log Report

With Stellar EDB to PST Converter, you can save the Log Report to analyze the conversion process at
a later stage.

To save the log report:
e From Logs menu, select Log Report.

¢ InLog Report dialog box, click Save Log.

Log Report ==
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e In Save As dialog box, specify the location where you want to save the log file. Click Save.
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FAQs

1. What is the difference between 'Online' and 'Offline' conversion of EDB to PST files?

In Online conversion, EDB files on running server are converted into PST files, while in Offline

conversion, EDB files stored on a local machine are converted into PST files.
2. What is the difference between an EDB file and a STM file?

The .EDB file is the main repository for the mailbox data. The STM or streaming media file is used
in conjunction with the .EDB file to comprise the Exchange database. Both files together make up
the database, and as such, they should always be treated as a single entity. Typically, if you
perform an action on the EDB file, the STM file is automatically included. The purpose of the STM

file is to store streamed native Internet content.

When you install a new Exchange server in an organization, two data stores are created
automatically: a default mailbox store and default public folder store. Two database files are

associated with the default mailbox store:

Priv1.EDB: A rich-text database file containing message headers, message text, and standard

attachments.

Priv1.STM: A streaming internet content file containing audio, video and other media that are

formatted as streams of Multipurpose Internet Mail Extensions (MIME) data.

The STM file houses Internet content message streams as defined in Request for Comments (RFC

822), and the EDB file contains messages that are in MAPI format (Rich Text Format).

When an Internet mail message comes into the Exchange information store, the body of the
message is saved in the STM file, and the header information (From, To, Cc, Time Sent, and so on)
is converted to Rich Text Format (RTF), and then stored in the EDB file.

3. While trying to activate the software, I'm getting an error message that the software is not

installed correctly. How can | activate the software?

You need to start Crypkey service which is currently stopped. Kindly follow the steps below to start

Crypkey service.
e Goto Control Panel.

e Open Administrative.

39



40

e Then, open Services.
e Now, right click Crypkey License and click Start.
e After starting the Crypkey Service, try to activate the software.

4. Is the process of converting my EDB files on server into PST files same as the process of

converting my EDB files on local machine?

No. To convert EDB files on server into PST, you have to first connect to mailbox(s) on server. After
the connection is established, you can start the process of conversion. To know how to connect to
mailboxes, see Connect to Single / All Mailboxes topic of this help. For Offline conversion, you

simply need to select EDB file and start the process of conversion.
5. lam not able to find my EDB file, how do | locate it?
Use Find EDB option to search and locate the EDB files.

6. | want to convert my Calendars and address book, how do | convert them using Stellar
EDB to PST converter tool?

First you need to convert mailboxes from the EDB file using the software. Then, import the PST file

in Outlook and check your calendars and address book.
7. Why do | require to convert EDB files into PST files?
There are different scenarios when a user may want to convert EDB files to PST files:

e If a user wants to take backup of mailbox(s) of ex-employee(s), before removing them from
exchange server then user has to convert their mailbox(s) into PST file(s) by using Stellar
EDB to PST Converter.

e If a user needs to check mailbox of any employee for any reason, he has to first convert

EDB file on server into PST file. Then open this PST file in Outlook to read mails.

e To take backup of selective mailboxes, a user has to convert EDB file into PST files first.

These PST files can be used as backup.



Legal Notices

Copyright

Stellar EDB to PST Converter software, accompanied user manual and documentation are copyright of
Stellar Information Technology Private Limited, with all rights reserved. Under the copyright laws, this
user manual cannot be reproduced in any form without the prior written permission of Stellar Information
Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the

information contained herein.

Copyright © Stellar Information Technology Private Limited. All rights reserved.

Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject

to change without notice.

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH
REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR
ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR
INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES
INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS
OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND
THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED,
BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES,
WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION
WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE
THEREOF.

Trademarks
StellarEDBtoPSTConverter® is a registered trademark of Stellar Information Technology Private Limited.
All Trademarks Acknowledged.

All other brands and product names are trademarks or registered trademarks of their respective

companies.

License Agreement

Stellar EDB to PST Converter
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Copyright © Stellar Information Technology Private Limited INDIA

www.stellarinfo.com

All rights reserved.

All product names mentioned herein are the trademarks of their respective owners.
This license applies to the standard-licensed version of Stellar EDB to PST Converter.
Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by Stellar Information Technology Private
Limited.

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or
use any copy of Stellar EDB to PST Converter with which this License is included, you may return the
complete package unused without requesting an activation key within 30 days after purchase for a full

refund of your payment.

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of
Stellar EDB to PST Converter. For purposes of this License, if you have a valid single-user license, you
have the right to use a single Licensed Copy of Stellar EDB to PST Converter. If you or your organization
has a valid multi-user license, then you or your organization has the right to use up to a number of
Licensed Copies of Stellar EDB to PST Converter equal to the number of copies indicated in the

documents issued by Stellar when granting the license.
Scope of License

Each Licensed Copy of Stellar EDB to PST Converter may either be used by a single person or used
non-simultaneously by multiple people who use the software personally installed on a single workstation.

This is not a concurrent use license.

All rights of any kind in Stellar EDB to PST Converter, which are not expressly granted in this license, are
entirely and exclusively reserved to and by Stellar Information Technology Private Limited. You may not
rent, lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works based
on Stellar EDB to PST Converter nor permit anyone else to do so. You may not make access to Stellar
EDB to PST Converter available to others in connection with a service bureau, application service

provider or similar business nor permit anyone else to do so.

Warranty Disclaimers and Liability Limitations
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Stellar EDB to PST Converter and all accompanying software, files, data and materials are distributed
and provided AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge
that good data processing procedure dictates that any program including Stellar EDB to PST Converter
must be thoroughly tested with non-critical data before there is any reliance on it and you hereby assume
the entire risk of all use of the copies of Stellar EDB to PST Converter covered by this License. This
disclaimer of warranty constitutes an essential part of this License. In addition, in no event does Stellar
authorize you or anyone else to use Stellar EDB to PST Converter in applications or systems where its
failure to perform can reasonably be expected to result in a significant physical injury or in loss of life. Any
such use is entirely at your own risk and you agree to hold Stellar harmless from any and all claims or

losses relating to such unauthorized use.

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special,
incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss
of business profits, business interruption, loss of business information, or any other pecuniary loss)
arising out of the use of or inability to use the software product or the provision of or failure to provide
support services, even if Stellar Information Technology Private Limited has been advised of the
possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability

under any provision shall be limited to the amount actually paid by you for the software product.
General

This License is the complete statement of the agreement between the parties on the subject matter and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive
jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the
State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries
of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any
violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or

future violation of the same provision or any other provision of this License.

Copyright © Stellar Information Technology Private Limited. All rights reserved.
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About Stellar

Stellar Information Technology Private Limited is a trusted name in the field of Data Recovery and Data

Protection Software for more than a decade.

We provide the widest range of Data Recovery Products. Our range includes Data Recovery Software for

almost all Operating Systems and File Systems.

Product line:
Data Recovery

A widest range of data recovery software that helps you recover your valued data lost after accidental

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >>
File Recovery

The most comprehensive range of file undelete and unerase software for Windows and MS office repair

tools. More Info >>
E-mail Recovery

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook
Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail.

More Info >>
Data Protection

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure

complete data protection against hard drive crash. More Info >>
Data Sanitization

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives,
System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >>

For more information about us, please visit www.stellarinfo.com
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